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Preface

Welcome to the TB8100 Calibration Kit User’s Manual. This manual provides 
you with information about the Tait TB8100 Calibration Kit in PDF format. 
You can view it online or print it if you want a paper copy. It describes how to 
use Version 02.00 of the Calibration Kit. 

Enquiries and Comments
Any enquiries regarding this manual as well as any comments, suggestions and 
notifications of errors should be sent to support@taitworld.com, or addressed 
to the Support Group Manager, Tait Electronics Limited, PO Box 1645 
Christchurch, New Zealand.

Updates of Manual and Equipment
In the interests of improving the performance, reliability or servicing of the 
equipment, Tait Electronics Limited reserves the right to update the equipment 
or this manual or both without prior notice. 

Copyright
All information contained in this manual is the property of Tait Electronics 
Limited. All rights are reserved. This manual may not, in whole or in part, be 
copied, photocopied, reproduced, translated, stored, or reduced to any 
electronic medium or machine-readable form, without prior written 
permission from Tait Electronics Limited. All trade names referenced are the 
service mark, trademark or registered trademark of the respective 
manufacturers.

Disclaimer
There are no warranties extended or granted by this manual. Tait Electronics 
Limited accepts no responsibility for damage arising from use of the information 
contained in the manual or of the equipment and software it describes. It is the 
responsibility of the user to ensure that use of such information, equipment and 
software complies with the laws, rules and regulations of the applicable 
jurisdictions.

Typographical Conventions
‘File > Exit’ means ‘click File on the menu bar, then select Exit’.

Associated Documentation
� Online Help. The Calibration Kit also has online Help. It contains more or 

less the same information as this manual. To view it, start the Calibration 
Kit, then press F1 or click the Help icon on the toolbar. If you are in a dialog 
box, click the Help button.

� TB8100 Installation Guide.

� TB8100 Installation and Operation Manual. 

� TB8100 Service Manual (service centers only). A glossary of terms is available 
in this manual.
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� TB8100 Service Kit User’s Manual. The Service Kit is a Windows-based 
software program that makes it easy to monitor and configure a Tait 
TB8100 base station. You can also use it to carry out diagnostic tests on the 
base station and to update its firmware. The Service Kit also has online Help.

Technical notes are published from time to time to describe applications for 
Tait products, to provide technical details not included in manuals, and to offer 
solutions for any problems that arise. Look for them on Tait's technical support 
website. The following have been published or are in development: 

� TN-742 Remotely Monitoring and Configuring the Tait TB8100. 

� TN-743 Using the Tait TB8100 as a Talk-Through Repeater. 

� TN-745 Using the Tait TB8100 in TaitNet Trunked Networks. 

� TN-744 Using the Tait TB8100 as a Line-Connected Base Station. 

Publication Record

Version Date Description

1.0 June 
2003

First release of the manual for Version 1.0.0 
of the Tait TB8100 Calibration Kit software.

02.00 March 
2004

Minor quality issues resolved and software 
changes documented for Version 02.00.
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About TB8100 Calibration Kit

The TB8100 Calibration Kit is a Windows-based software program that allows 
you to adjust the switching ranges of the receiver and transmitter, and flatten 
the receiver response across the switching range. 

Accredited Tait service centers can use the TB8100 Calibration Kit to calibrate 
the reciter and the PA after servicing.

Tour of TB8100 Calibration Kit
When you start the TB8100 Calibration Kit, the main program window 
appears.

The main program window has three tabs. The Calibration Wizards displayed 
on each tab are only visible once you are connected to the reciter and/or base 
station.

Frequency Setup 
tab

Shows the three Calibration Wizards that take you step-by-step through the 
frequency setup.

Reciter Calibration 
tab

Shows the seven calibration procedures that you can perform on the reciter. 
The Calibration Wizard takes you step-by-step through the procedure you 
have selected.

PA Calibration tab Shows the three calibration procedures that you can perform on the power 
amplifier. The Calibration Wizard takes you step-by-step through the 
procedure you have selected.

When the TB8100 Calibration Kit is connected to the reciter or base station, 
you can view further details (such as module number, type, serial number, and 
band) about the currently selected reciter and/or PA by clicking Show Details.

Menu bar

Toolbar

Calibration 
Wizards

Status bar
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About the Toolbar
The toolbar gives you quick access to commonly used menu commands. For 
example, instead of selecting Base Station > Calibrate, you can click the 
Calibrate icon on the toolbar.

Connect Connects the TB8100 Calibration Kit to the base station and opens the 
communication channels.

Switch Base 
Station

Lets you select another base station to calibrate if there are multiple base stations 
in the rack.

Calibrate Runs the Calibration Wizard for the currently selected task.

Options Allows you to set the COM port and default calibration mode.

Help Opens the online help for the window you are currently in.

About the Status Bar
The status bar provides you with useful information that supplements the 
display in the main window.

Miscellaneous messages COM port in use
6 Tour of TB8100 Calibration Kit MB8100-90-00-806   © TEL 2004



Basic Tasks

Before you start tuning and calibrating the base station, make sure that:

1. You have all the necessary equipment for the particular procedure(s) that 
you want to perform, and

2. Your PC is connected to the base station or reciter.

If you want to define the switching range for a base station (if this has not 
already been done), start here: “Adjusting the Frequency Setup” on page 15.

Equipment Required
You need the following equipment to tune and calibrate the base station:

� AC millivoltmeter (one with a differential input may be required for  
“Calibrating the Balanced Lines” on page 23)

� Calibration test unit (CTU) (order code TBA0ST1) which comes with the 
cables you will need for connection to the reciter/PA and the PC

� Calibration test kit (order code TBA0ST2) which comprises a tuning tool 
and the required screwdrivers in a tool pouch

� 10-30 V DC power supply

� RS-232 cable

� Frequency counter 

� Modulation meter

� RF attenuator (optional – depends on the setup)

� RF signal source

Refer to the individual procedures for equipment setup diagrams.

For more information about the calibration test unit, please refer to the TN-778 
Application Note.

25-way cable

15-way TaitNet 
cable

16-way cable

Power cable

RF cable

BNC to BNC 
cable
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Tuning Tool
The recommended tuning tool (for adjusting the front-end helical filters and 
the VCOs in the reciter) is included in the calibration test kit (see Equipment 
Required). It can also be ordered separately (order code 937-00012-00).

Reciter Tuning Holes
The following topics show the location of the holes for tuning the front-end 
helical filters, and the VCO (Voltage Controlled Oscillator) in the reciter.

Adjusting the 
frequency

When you tune the VCOs and the front-end helical filters, turn the tuning tool:

� Clockwise to reduce the frequency

� Anti-clockwise to increase the frequency

Holes for Tuning the Receiver VCO and Exciter VCO
The holes for tuning the receiver VCO and exciter VCO are shown below.

Holes for Tuning the Receiver Front-End
When running the Tune Receiver Wizard, you will need to tune both sets of 
front-end helical filters. Each set consists of three holes (see the following 
photograph).

Use the tuning tool as follows:

1. Insert the tuning tool into the first hole of the first set. You can start with 
the hole on the left side and proceed along to the hole on the right, or vice 
versa (never start with the centre hole). 

20 mm

Bit shape:

Blade diameter: 2.2 mm Blade thickness: 0.4 mm

Exciter VCO 
tuning hole

Receiver VCO 
tuning hole

Sets of front-end 
helical filters
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2. Tune each of the resonators in the first set once to give the best response. 

3. Insert the tuning tool into the first hole of the second set. You can start with 
the top hole and proceed down to the bottom hole, or vice versa (again, 
never start with the centre hole). 

4. Tune each of the resonators in the second set once to give the best response.

5. Repeat this procedure as necessary to refine the response.

Configuring TB8100 Calibration Kit
Note: For information on computer system requirements, and 
installing the TB8100 Calibration Kit, see the TB8100 Installation 
and Operation Manual.

Selecting the Communications Port
Before you connect to a base station, you should first define the 
communications (COM) port that you want to use.

To select the COM port

1. Select Tools > Options.

2. Select the port that you want to use from the COM Port list. 

Note: The available COM ports are detected by the program and 
appear in the list.

3. Click OK.

The COM port you selected is now shown on the status bar.

First set

Second set
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Connecting to the Base Station
Depending on the procedure you are performing, you may need to remove the 
reciter from the subrack and connect to it via the calibration test unit (CTU). 

The following tables summarise, for each procedure, whether or not you need 
to remove a module from the subrack, and what equipment (in addition to a 
PC and the TB8100 Calibration Kit software) you will need.

For instructions on how to connect to the reciter depending on whether it is 
outside or inside the subrack, refer to:

� “Connecting to the Reciter Outside the Subrack” on page 11

� “Connecting to the Reciter/PA in the Subrack” on page 12

Reciter

Power Amplifier

Procedure
Inside/Outside 
Subrack

Equipment Required

Adjusting receiver lock band Outside subrack Tuning tool, CTU

Tuning the receiver Outside subrack Tuning tool, CTU

Adjusting exciter lock band Outside subrack Tuning tool, CTU

Automatically tuning FCL Inside subrack None required

Calibrating the FCL modulation Outside subrack Tuning tool, CTU, 
modulation meter, RF 
attenuator (only if using PA)

Calibrating the VCO modulation Outside subrack Tuning tool, CTU, 
modulation meter, RF 
attenuator (only if using PA)

Calibrating the RSSI Inside subrack RF signal source

Calibrating the balanced lines Inside subrack CTU, AC millivoltmeter

Calibrating the unbalanced lines Inside subrack CTU, AC millivoltmeter

Calibrating the TCXO Inside subrack Frequency counter, RF 
attenuator (only if using PA)

Procedure
Inside/Outside 
Subrack

Equipment Required

Calibrating the PA bias Inside subrack None required

Calibrating the forward & 
reverse detector bias voltages

Inside subrack None required

Calibrating the PA power Inside subrack None required
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Connecting to the Reciter Outside the Subrack 
For the reciter calibration procedures that require access to the tuning holes, 
you will need to remove the reciter from the subrack and connect to it as 
follows.

Equipment � Calibration test unit (CTU)

� An IBM compatible PC

� 10-30 V DC power supply

� 16-way cable

� RS-232 cable

Setup

To connect to the reciter

1. Remove the reciter from the subrack.

2. Set up the equipment as follows:

� Connect the reciter to the calibration test unit (CTU) using the 16-way 
cable.

� Connect your computer to the CTU by plugging the RS-232 cable into 
the programming port. 

� Using the power cable supplied in the calibration test kit, connect the 
reciter to the 10-30 V DC power supply, but do not power it up yet.

3. Start the TB8100 Calibration Kit program, and check that the correct COM 
port is selected.

4. Click Connect to start the connection process.

5. When you see the “Waiting for logon prompt from Reciter” screen, power 
up the reciter. 

6. When the TB8100 Calibration Kit program has successfully connected to 
the reciter, the Calibration Wizards are displayed in the main window.

You are now ready to tune and calibrate the reciter.

3

64

5

2
1

7

8

1 PC 5 16-way cable

2 RS-232 cable 6 Reciter

3 CTU 7 Power cable

4 Programming port 8 10-30 V DC power supply
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Connecting to the Reciter/PA in the Subrack 
For the PA calibration procedures and the reciter calibration procedures that do 
not require access to the tuning holes, you can leave the modules in the subrack 
and connect your PC to the base station as follows.

Equipment � An IBM compatible PC

� RS-232 cable

Setup

To connect to the base station

1. Connect your computer to the base station by plugging the RS-232 cable 
into the serial port of the base station’s control panel.

2. Start the TB8100 Calibration Kit program, and check that the correct COM 
port is selected.

3. Click Connect to start the connection process.

4. As soon as you see the “Waiting for logon prompt from Reciter” screen, 
power up the base station. 

5. When the TB8100 Calibration Kit program has successfully connected to 
the base station, the Calibration Wizards are displayed in the main window.

You are now ready to calibrate the reciter or PA.

Disconnecting from the Base Station/Reciter
To disconnect from the base station or reciter before closing the program, select 
File > Exit, or click Disconnect.

Important: Before disconnecting from the base station, ensure that 
you have completed any calibration process that you have started. If 
a calibration process is not completed, the base station could be left 
in an uncalibrated state.

4

1

3

2

1 Base station 3 RS-232 cable

2 Serial port 4 PC
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Basic Troubleshooting

Application Errors All application errors are recorded in a log file called “CalError.log”. The data, 
time, location, and any other useful information is stored in this file, which may 
be helpful when troubleshooting. 

The file is saved in the Logfiles folder (..\Program Files\Tait Programming 
Applications\TB8100 Service Kit\LogFiles), and stores up to 1000 of the most 
recent logged items.

Verifying the 
Software Version

If you need to verify the version of the TB8100 Calibration Kit, select 
Help > About.
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Adjusting the Frequency Setup

Before the TB8100 base station is installed, connected, and configured, you 
must prepare it for operation by adjusting the switching range of the reciter, and 
flattening the receiver response across the base station’s switching range.

Note:  If the required switching range for the base station has already 
been defined, you don’t need to perform these procedures.

To prepare the base station for operation

1. Adjust the receiver lock band (optional)

2. Tune the receiver

3. Adjust the exciter lock band (optional)

Tip: Use the TB8100 Service Kit software to monitor the base 
station and find out its current switching range.

Adjusting the Receiver Lock Band
The first step in preparing the TB8100 base station for operation is to adjust the 
receiver lock band (switching range). The lock band is the range of frequencies 
that the base station receiver or transmitter is calibrated to operate on.

Equipment � Tuning tool

� Calibration test unit (CTU)

To adjust the receiver lock band

1. Ensure you are already connected to the reciter.

2. Select the Frequency Setup tab, and double-click Set Receiver VCO. The 
Set Receiver VCO Wizard appears.

3. Enter the Center Frequency (which must be a multiple of 500 kHz) of the 
lock band that you want to use, and click Next.

4. Insert the tuning tool into the receiver VCO tuning hole and then click 
Next.

5. Adjust the receiver VCO trimmer to center the receiver VCO on the 
frequency you want, and then click Finish.

The lock band is now stored in the reciter, and the icon  on the Frequency 
Setup tab indicates that this task is complete. You will now need to tune the 
receiver front end.
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Tuning the Receiver
The second step in tuning the reciter frequency is to tune the receiver front 
end. Tuning the receiver flattens the receiver’s response across its lock band 
(switching range).

To help you do this, there is a graph of the RSSI readings in step two of the 
Tune Receiver Front End Wizard. A number of RSSI readings are measured 
across the 10 MHz band. These readings are then continually averaged to 
produce the graph.

You should aim to achieve a response that looks something like this:

Equipment � Tuning tool

� Calibration test unit (CTU)

Setup

To tune the receiver

1. Ensure you are already connected to the reciter.

2. Select the Frequency Setup tab, and double-click Tune Receiver Front 
End. The Tune Receiver Front End Wizard appears.

3. Connect the CTU’s noise source to the receiver input, turn the noise source 
on, and then click Next.

4. For each set of front-end helical filters, insert the tuning tool into each 
tuning hole. (For the tuning sequence, refer to “Holes for Tuning the 
Receiver Front-End” on page 8.) Click Coarse (fast) and roughly adjust 
the front-end helical filters on the receiver. As you do so, observe the 
graphical RSSI readings across the lock band.

Note: As the response gets flatter, you may find it helpful to select a 
more sensitive scale, so that you can see the graphical reading in 
more detail.

3
2

1

1 CTU 2 Noise source 3 Reciter
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5. Once you have roughly tuned the front-end helical filters, click Fine 
(slow). Continue to fine tune the front-end helical filters until the response 
is flat in the middle of the lock band and not more than -1 dB at the ends 
of the band (± 5 MHz). 

Note: When using the Fine (slow) setting, you may notice a slight 
delay as the reading from tuning the front-end helical filters takes 
approximately one second to appear on the graph.

6. Click Finish.

Once you have finished tuning the receiver, the icon  on the Frequency 
Setup tab indicates that this task is complete.

Adjusting the Exciter Lock Band
If you are preparing the base station for operation, adjusting the exciter lock 
band is the third step in tuning the reciter. Otherwise, this procedure can be 
performed independently of the other two calibration wizards on the 
Frequency Setup tab. Adjusting the exciter lock band defines the range of 
frequencies that the base station is able to transmit on.

Note: When performing this procedure, you don’t need to 
terminate the exciter output port. An internal output pad means that 
there is a good impedance match at this interface.

Equipment � Tuning tool

� Calibration test unit (CTU)

To calibrate the exciter lock band

1. Ensure you are already connected to the reciter.

2. Select the Frequency Setup tab, and double-click Set Exciter VCO. The 
Set Exciter VCO Wizard appears.

3. Enter the center frequency (which must be a multiple of 500 kHz) of the 
lock band that you want to use, and click Next.

4. Insert the tuning tool into the exciter VCO tuning hole and adjust the 
trimmer to roughly center the exciter VCO on the band you want. Click 
Finish.

Once you have finished adjusting the exciter lock band, the icon  on the 
Frequency Setup tab indicates that this task is complete.
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Calibrating the Reciter

The reciter is fully calibrated in the factory, but if the reciter is serviced you may 
need to perform the following procedures:

� Calibrating the Exciter

� Calibrating the RSSI

� Audio Calibration

� Calibrating the TCXO

These procedures can be done independently of each other, although it is 
recommended that you tune the receiver before you calibrate the RSSI.

Important:  It is recommended that only accredited service centers 
and Tait engineers perform these procedures.

Advanced 
Troubleshooting

All the commands sent and received by TB8100 Calibration Kit are saved in a 
file called “CCTM.log”. The date, time, command number, and parameters are 
all stored in this file, which may be helpful when troubleshooting.

The file is saved in the Logfiles folder (..\Program Files\Tait Programming 
Applications\TB8100 Service Kit\LogFiles), and stores up to 1000 of the most 
recent logged items.

Calibrating the Exciter
You will need to calibrate the exciter if you have made component-level repairs 
to it. There are three steps:

1. Auto-tune the FCL

2. Calibrate the FCL modulation

3. Calibrate the VCO modulation

Automatically Tune the Frequency Control Loop (FCL)
This is step one of calibrating the exciter.

Low frequencies (CTCSS and DCS) are modulated using the FCL (frequency 
control loop). The FCL forms a loop that allows the reference frequency to be 
modulated.

To automatically tune the FCL

1. Ensure you are already connected to the reciter.

2. Select the Reciter Calibration tab, and double-click FCL Auto Tuning. 
The FCL Auto Tuning Wizard appears.

3. Click Calibrate to automatically tune the FCL.

The icon  on the Reciter Calibration tab indicates that this task is complete.

You will now need to calibrate the FCL modulation.
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Calibrating the FCL Modulation
This is step two of calibrating the exciter. Once you have auto-tuned the FCL, 
you should calibrate the FCL modulation.

Equipment � Tuning tool

� Calibration test unit (CTU)

� Modulation meter

� RF attenuator (only required if you are using a PA)

Setup

To calibrate the FCL modulation

1. Ensure you are already connected to the reciter.

2. Select the Reciter Calibration tab, and double-click FCL Calibration. The 
FCL Calibration Wizard appears.

3. Attach an appropriate Load and Modulation meter to the PA or exciter 
output, set the meter to measure the RMS deviation, and then click Next. 
(If you are using a PA, it will now transmit.)

4. Insert the tuning tool into the exciter VCO tuning hole and adjust the 
trimmer to roughly center the exciter VCO on the band specified. Click 
Next.

5. Use the slider to adjust the deviation at 30 Hz until it is 2121 Hz RMS (3 kHz 
peak).

6. Select the 1 kHz Modulation Test and adjust the deviation at 1 kHz until it 
is 2121 Hz RMS (3 kHz peak).

7. Repeat steps 6 and 7 until the modulation is 2121 Hz RMS at both 30 Hz 
and 1 kHz.

8. Click Finish. (If you are using a PA, it will now stop transmitting.)

When you have finished calibrating the FCL modulation, the icon  on the 
Reciter Calibration tab indicates that this task is complete.

You will now need to calibrate the VCO modulation.

1 Reciter 3 RF attenuator (only required if using a PA)

2 PA (optional) 4 Modulation meter

1 2

3

4
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Calibrating the VCO Modulation
This is step three of calibrating the exciter.

Once you have tuned and calibrated the FCL, you should calibrate the VCO 
at frequencies across the band.

Equipment � Tuning tool

� Calibration test unit (CTU)

� Modulation meter

� RF attenuator (only required if you are using a PA)

Setup

To calibrate the VCO modulation

1. Ensure you are already connected to the reciter.

2. Select the Reciter Calibration tab, and double-click VCO Calibration. 
The VCO Calibration Wizard appears.

3. Attach an appropriate Load and Modulation meter to the PA or exciter 
output, set the meter to measure the peak deviation, and then click Next. 
(If you are using a PA, it will now transmit.)

4. Using the scale in the dialog box to help you, adjust the exciter lock band 
trimmer to center the exciter VCO on the sub-band indicated and then 
click Next.

5. For each of the seven frequencies shown, adjust the slider until the deviation 
shown on the modulation meter is 3000 Hz (peak). When you have 
finished, click Next Band.

6. For each sub-band repeat steps 4 and 5.

7. Click Finish. (If you are using a PA, it will now stop transmitting.)

When you have finished calibrating the VCO modulation, the icon  on the 
Reciter Calibration tab indicates that this task is complete.

You should now adjust the exciter lock band because it was re-tuned several 
times during this procedure. This means that the exciter is no longer on the 
required frequency.

1 Reciter 3 RF attenuator (only required if using a PA)

2 PA (optional) 4 Modulation meter

1 2

3

4
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Calibrating the RSSI
Calibrating the RSSI (received signal strength indicator) ensures that the 
reciter's internal RSSI values accurately reflect the actual received signal 
strength. Changing the receiver's lock band can alter the calibration accuracy by 
about 1 dB. 

Note: Ensure that the receiver’s lock band has already been adjusted 
to the required setting before carrying out this procedure. (See 
“Adjusting the Receiver Lock Band” on page 15.)

Equipment � RF signal source

Setup

To calibrate the RSSI 

1. Ensure you are already connected to the reciter.

2. Select the Reciter Calibration tab, and double-click RSSI Calibration. 
The RSSI Calibration Wizard appears.

3. Apply a signal (modulated at 1 kHz tone, 3kHz deviation peak) at the base 
station’s center frequency. Use the CTU to confirm that the tone is being 
output on the line, and then click Next.

4. Set the RF input signal to a level of -80 dBm, and then click Next.

5. Vary the RF level, and check that the value shown in the RSSI Gain Setting 
box corresponds with the value shown on your test instrument. This is to 
make sure the RSSI is correctly calibrated. Click Finish.

When you have finished calibrating the RSSI, the icon  on the Reciter 
Calibration tab indicates that this task is complete.

1

2

1 RF signal source

2 Reciter
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Audio Calibration
You should calibrate the audio outputs/inputs if the system interface has been 
replaced or changed at all.

Note: The balanced and unbalanced lines can be calibrated 
independently of each other.

Calibrating the Balanced Lines
Calibrating the balanced lines adjusts their gain, so that when you set line levels 
using the TB8100 Service Kit software, the actual line level correctly reflects 
the Service Kit settings. (Refer to the TB8100 Service Kit User’s Manual for 
further information.)

Equipment � Calibration test unit (CTU)

� AC millivoltmeter

Important:  If the reciter you are calibrating has either the product 
code TBA4xxx-0A0x or TBA5xxx-0A0x, its balanced line output 
is not transformer isolated. Ensure that the line meter you are using 
has a differential input otherwise the balanced line output will not 
be calibrated properly.

Setup for 
Balanced Line Out

Setup for 
Balanced Line In

1
63
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2

5

1 Reciter 3 CTU 5 Line output

2 25-way cable 4 System interface port 6 AC millivoltmeter

1
3

5 6

4

2

1 Reciter 3 CTU 5 Line input

2 25-way cable 4 System interface port 6 Line output
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To calibrate the balanced input and output lines

1. Ensure you are already connected to the reciter.

2. Select the Reciter Calibration tab, and double-click Balanced Line 
Calibration. The Balanced Line Calibration Wizard appears.

3. Attach an AC millivoltmeter and terminate the balanced output in 600 
ohms (either using the load on the CTU or looping the balanced output to 
the balanced input), and then click Next.

4. Adjust the slider in the dialog box until the audio level on the millivoltmeter 
reads 1 VPP (0.354 VRMS) to calibrate the balanced line output, and then 
click Next.

Note: Click Coarse to roughly adjust the audio level, and once you 
get within range, click Fine for more precise control over the 
settings. To move up or down 10 mVPP, click either side of the 
slider bar.

The balanced output is now calibrated.

5. Ensure that the 600 ohm load on the CTU is turned off, and then connect 
the balanced output to the balanced input. Click Finish.

The balanced input is now calibrated.

When you have finished calibrating the balanced lines, the icon  on the 
Reciter Calibration tab indicates that this task is complete.

Calibrating the Unbalanced Lines
Calibrating the unbalanced lines adjusts their gain, so that when you set line 
levels using the TB8100 Service Kit software, the actual line level correctly 
reflects the Service Kit settings. (Refer to  the TB8100 Service Kit User’s Manual 
for further information.)

Equipment � Calibration test unit (CTU)

� AC millivoltmeter

Setup for 
Unbalanced Line 
Out

1
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1 Reciter 3 CTU 5 Unbalanced line output

2 25-way cable 4 System interface port 6 AC millivoltmeter
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Setup for 
Unbalanced Line 
In

To calibrate the unbalanced input and output lines

1. Ensure you are already connected to the reciter.

2. Select the Reciter Calibration tab, and double-click Unbalanced Line 
Calibration. The Unbalanced Line Calibration Wizard appears.

3. Attach an AC millivoltmeter to the unbalanced line output, and then click 
Next.

4. Adjust the slider in the dialog box until the audio level on the millivoltmeter 
reads 1 VPP (0.354 VRMS) to calibrate the unbalanced line output, and then 
click Next.

Note: Click Coarse to roughly adjust the audio level, and once you 
get within range, click Fine for more precise control over the 
settings. To move up or down 10 mVPP, click either side of the 
slider bar.

The unbalanced output is now calibrated.

5. Connect the unbalanced output to the unbalanced input, and then click 
Finish.

The unbalanced input is now calibrated.

When you have finished calibrating the unbalanced lines, the icon  on the 
Reciter Calibration tab indicates that this task is complete.

Calibrating the TCXO
The TCXO (temperature compensated crystal oscillator) provides a reference 
frequency from which all other RF frequencies are derived.

You will need to calibrate the TCXO if you suspect that the reciter (specifically, 
the transmitter and receiver) is off-frequency. (Off-frequency is defined as being 
outside the range of -1 to +1 ppm.) This may occur for a variety of reasons. 
Over time the reciter frequency will become less accurate, so it is a good idea 
to calibrate the TCXO every few years. Exactly how often you do this will 
depend on the harshness of the conditions in which the base station is operating. 

Ideally, you should calibrate the TCXO at a room temperature of 25 ± 5 
degrees Celsius. Complete the calibration as quickly as possible since extended 
transmission times increase temperature, which makes the calibration less 
accurate.

1
3

5 6

4

2

1 Reciter 3 CTU 5 Unbalanced line input

2 25-way cable 4 System interface port 6 Unbalanced line output
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Equipment � Frequency counter

� RF attenuator (only required if you are using a PA)

Important: The accuracy of the calibrated TCXO frequency is only 
as good as the accuracy of the frequency counter.

Setup

To calibrate the TCXO

1. Ensure you are already connected to the reciter.

2. Select the Reciter Calibration tab, and double-click Carrier Freq Offset 
Adjustment. The Carrier Freq Offset Adjustment Wizard appears.

3. Attach an appropriate load and frequency counter (or a test set) to the exciter 
or PA output, and then click Next. (If you are using a PA, it will now 
transmit.)

4. Using the slider, adjust the TCXO until the actual frequency is exactly the 
same as the selected frequency value. Click Coarse to roughly (and quickly) 
adjust the output frequency, and then click Fine to fine-tune it. When you 
have finished, click Finish. (If you are using a PA, it will now stop 
transmitting.)

When you have finished calibrating the TCXO, the icon  on the Reciter 
Calibration tab indicates that this task is complete.

1 2

3

4

1 Reciter 3 RF Attenuator pad (optional)

2 PA (optional) 4 Frequency counter
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Calibrating the Power Amplifier

The PA is fully calibrated in the factory, but if the PA is serviced you may need 
to perform the following procedures:

� Calibrating the PA Bias

� Calibrating the PA Power

� Calibrating the Forward and Reverse Detector Bias Voltages

Important:  It is recommended that only accredited service centers 
and Tait engineers perform these procedures.

Note: The PA is calibrated by the microprocessor via the Calibration 
Kit. You do not need to make any manual adjustments. 

The power amplifier (PA) receives the RF signal from the reciter 
and amplifies it to the required level, in watts, as requested by the 
reciter. The desired output power is determined by the reference 
voltage for the power control loop.

Calibrating the PA Bias
The driver and final transistors of the power amplifier must be biased at a 
constant current. Since the characteristics of individual transistors vary slightly, 
the bias current is calibrated for each device.

If either the driver or final transistor, or the PCB modules themselves, are 
replaced during servicing, you should perform this procedure to calibrate the 
bias current for the new device.

The bias current required for each amplifier stage is stored within the PA. 
During the calibration process, the microprocessor adjusts the gate bias voltage 
to obtain the required bias current for each stage.

The stage bias calibration sets up the amplifier’s DC operating conditions. 
These DC conditions will be upset if there is RF present during calibration. It 
is important to disconnect the RF cable from the PA input to avoid this. 

The other conditions which must be met to ensure a successful calibration are 
as follows:

� No other Calibration Wizards are running

� The supply voltage is within the range 27-29V

� The temperature of each stage is within the range 5-50°C

To calibrate the PA stage bias current

1. Ensure you are already connected to the base station.

2. Select the PA Calibration tab, and double-click Calibrate PA Bias.

3. Ensure that the exciter RF is isolated from the PA by disconnecting the 
SMA connector on the PA front panel.

4. Click Calibrate to calibrate the PA bias.

When you have finished calibrating the power amplifier bias, the icon  on 
the PA Calibration tab indicates that this task is complete.
TB8100 Calibration Kit User’s Manual   Calibrating the PA Bias 27



Calibrating the PA Power
Important: Before you perform this procedure, you must calibrate 
the PA bias and the forward and reverse detector bias voltages. 

The PA power control loop is calibrated at a single frequency, generally in the 
center of the operating band. Factory calibration is performed at 460 MHz. 

You perform the calibration procedure to define – for each power level – the 
reference DAC (Digital-to-Analogue Converter) value and forward detector 
voltage.

You should only need to re-calibrate the PA power if: 

� The Low Pass Filter (LPF)/directional coupler PCB module is replaced

� Any repairs are carried out on the forward and reverse detector circuitry on 
the Low Pass Filter/directional coupler PCB module

� You require a more accurate power calibration on a specific frequency

Equipment

� Either an inline power meter and 50 ohm load with a high power rating, or

� A terminating power meter and appropriate 50 ohm attenuator with a high 
power rating

Setup for Inline 
Power Meter

To calibrate the PA transmit power

1. Ensure you are already connected to the base station.

2. Select the PA Calibration tab, and select Calibrate PA Power.

3. Ensure that the power meter and a 50 ohm load (VSWR < 1.2:1) with a 
high power rating are connected to the power amplifier RF output, and 
then click Next.

4. Check that the PA RF input is connected to the reciter RF output, and that 
the PA and the reciter are connected by a control bus, and then click Next.

5. For each power level shown, use the slider to adjust the DAC setting to get 
the required power output, and then click Next Power to move to the next 
line.

Note: Click Coarse to roughly adjust the DAC setting, and once 
you get within range, click Fine for more precise control over the 
settings. To move up or down one DAC value, click either side of 
the slider bar.

1 3

2

4

5

1 Reciter 3 PA 5 Load

2 16-way cable 4 RF Power Meter
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Note: You must perform the calibration in sequence from the lowest 
to the highest step. The DAC setting must be greater than the 
previous one otherwise the value will not be stored in the PA, and 
you cannot move to the next line.

6. When you have completed adjusting the DAC settings, click Finish.

When you have finished, the icon  on the PA Calibration tab indicates that 
this task is complete.

Troubleshooting Tips

DAC Settings When you adjust the DAC settings, the values for the DAC Setting, Coupler 
Fwd Voltage, and Control Voltage should always increase as the power level 
increases. If these values do not increase, there is either a fault with the PA or 
the previous step was not calibrated correctly. If you make a mistake in the 
calibration table, you must start again from step 1.

Control Voltage The Control Voltage is shown in the table to indicate the operation point 
within the power control loop. The range of the control voltage is from 0 V to 
7.5 V. If the control voltage reaches its limit before achieving maximum power 
in the table, this indicates either a faulty gain stage in the PA or low RF input 
power to the PA.

VSWR The VSWR (Voltage Standing Wave Ratio) is monitored at the RF output of 
the PA during calibration. The software will not allow calibration into a load 
VSWR > 1.3:1. If a calibration step cannot be stored, check that the load 
VSWR is <1.3:1. It is recommended that the load should have an input 
VSWR <1.2:1.

Calibrating the Forward and Reverse Detector Bias Voltages
The RF detectors, used for measuring the forward and reverse power, operate 
with a small bias current. The resulting bias voltage from each detector (with 
no RF present) is read and stored inside the PA. These voltages are used when 
calculating the Antenna VSWR (Voltage Standing Wave Ratio).  

You should calibrate the forward and reverse detector bias voltages:

� If the Low Pass Filter (LPF)/directional coupler PCB module is replaced

� After servicing of any components in the detector circuitry (such as the 
detector diodes) on the LPF/ directional coupler PCB

To calibrate the forward and reverse detector bias voltages

1. Ensure you are already connected to the base station.

2. Select the PA Calibration tab, and double-click Calibrate Fwd/Rev 
Detector Bias Voltages.

3. Ensure that the PA is not transmitting and that there is no RF source present 
at the PA RF input or output by disconnecting the input SMA connector 
on the PA front panel and the ‘N’ type output connector from the rear of 
the PA. Click Finish.

When you have finished, the icon  on the PA Calibration tab indicates that 
this task is complete.
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Index

A
AC millivoltmeter

see equipment
Antenna VSWR (Voltage Standing Wave Ra-

tio) 29
audio level

calibrating 24, 25

B
balanced input

calibrating 24
balanced output

calibrating 24
band 5
base station

connecting to 12
disconnecting from 12

bias current
required for each power level 27
RF detectors 29

C
calibration test kit

see equipment
calibration test unit (CTU)

connecting to computer 11
connecting to reciter 11
see also equipment

calibration wizards
Balanced Line Calibration Wizard 24
Calibrate Fwd/Rev Detector Bias Voltages

Wizard 29
Calibrate PA Bias Wizard 27
Calibrate PA Power Wizard 28
Carrier Freq Offset Adjustment Wizard 26
FCL Auto Tuning Wizard 19
FCL Calibration Wizard 20
RSSI Calibration Wizard 22
Set Exciter VCO Wizard 17
Set Receiver VCO Wizard 15
Tune Receiver Front End Wizard 16
Unbalanced Line Calibration Wizard 25
VCO Band Tuning Wizard 21

COM port 9
control voltage 29
coupler fwd voltage 29

D
DAC (Digital-to-Analogue Converter)

adjusting settings 28
detector

diodes 29
detectors

forward and reverse 29
directional coupler 28, 29
driver transistor 27

E
equipment

AC millivoltmeter 23, 24
calibration test kit 7
calibration test unit (CTU) 16, 23, 24
frequency counter 26
modulation meter 20, 21
power meter 28
RF attentuator 20, 21, 26
RF signal source 22
tuning tool 8, 15, 16, 17, 20, 21

exciter
adjusting lock band 17
calibrating 19, 19, 20, 21
component repairs to 19

exciter VCO
tuning hole 8

F
FCL (Frequency Control Loop)

calibrating the modulation 20
tuning automatically 19

final transistor 27
forward detector 28

calibrating bias voltage 29
frequency

adjusting using tool 8
calibrating 25
defining center frequency 15
defining range of 17
modulating reference frequency 19

frequency counter
see equipment

front end helical filters
tuning 16
tuning holes for 8
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G
gate bias voltage 27

L
lock band

definition 15
see exciter
see receiver

log files
application errors 13
commands received and sent 19

Low Pass Filter (LPF) 28, 29

M
modulation meter

see equipment
module number 5

O
operating range

see switching range

P
PA

calibrating bias current 27
calibrating RF detector bias voltages 29
calibrating transmit power 28
connecting to 12
details 5
faulty gain stage 29
low RF input power 29

PCB module 28, 29
peak deviation

measuring 21
power supply

see equipment

R
receiver

adjusting lock band 15
tuning front end helical filters 16

receiver VCO
tuning hole 8

reciter
calibrating 19
connecting to 11

connecting to in subrack 12
details 5
off-frequency 25
tuning the frequency 15

Reference DAC 28
resonators

see front end helical filters
reverse detector

calibrating bias voltage 29
RF attentuator

see equipment
RF detectors 29
RF signal source

see equipment
RMS (root means squared)

measuring deviation of 20
RSSI (Received Signal Strength Indicator)

tuning receiver 16

S
serial number 5
status bar 6
switching range

adjusting 15
definition 15

system interface 23

T
TCXO (Temperature Compensated Crystal

Oscillator)
calibrating 25

toolbar 6
troubleshooting

advanced 19
basic 13
PA power calibration 29

tuning holes 8–8

U
unbalanced input

calibrating 25
unbalanced output

calibrating 25

V
VCO (Voltage Controlled Oscillator)

see exciter VCO
see receiver VCO
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version
of software 13

VSWR 29
VSWR (Voltage Standing Wave Ratio) 28, 29

W
wizards

see calibration wizards
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